
Using Your Campus Email Account 
 Go on-line to: http://mail.csusb.edu:411/  Do a search for your last name to see if you are in the 
system. If you do not find your name in the EMAIL system it is because you have listed your private 
email address for Campus records through various forms.   

  You may go to the PDC Office to fill out a form called “Change of Address” to remove your private 
email address from student records.  This will open a Campus Email for you.  A week later you may go 
to the address above to search for your name and email address.  

The Email Address they provide for you tells you what your “User I.D.” is.   

Example:  if your Email Address is jsmith@csusb.edu  

Your User I.D. will be: jsmith  

Your Password will be the last 6 numbers of your Student I.D. or the last 6 digits of your Social Security 
number. 

You may access your campus email account from any Internet connection. Simply go to 
http://mail.csusb.edu, type in your User I.D. and Password.  

BASIC EMAIL FUNCTIONS  

You can use the CSUSB Campus Web Mail to write, send, receive, read, reply to, forward, delete, file, and find 
email. To manage your email, Messenger Express provides these tabs: 

Table 1 Using Messenger 
Express Tabs  
 
Messenger Express Tabs  

How to Use Them  

Folders Tab   Use this tab to view and work with folders, where messages are filed.  

Inbox Tab - or the tab for the 
folder where you are 
currently working.   

Use this tab to view and work with groups of messages. 

Sent Mail Tab   Use this tab to view a copy of the individual messages sent to people 
from your account.  

Trash Tab   Use this tab to store all deleted messages and folders. The messages 
in the Trash are deleted periodically. It is possible to recover deleted 
messages and folders from the Trash, within a stipulated time frame.   

Drafts Tab   Use this tab to save drafts of long messages before they are sent. This 
will ensure that your work is not lost if you encounter an interruption 
before you send the message.  

Addresses Tab   Use this tab to enter the names and email addresses of the people to 
whom you send messages.  

Options Tab   Use this tab to view information and options and to make choices 
about your email account.  

Managing Messages  
 

Getting New Messages  
 
To receive new messages, click Get Mail icon.  

http://mail.csusb.edu:411/
http://mail.csusb.edu:411/


Messenger Express lists messages in the Inbox window. Messages are displayed in a list that shows the sender's 
name, subject, date of receipt and size of the message. Messages that have an envelope next to them have not 
been read. The number of unread messages, displayed at the lower-left of the Inbox window, changes to include 
new messages.  

Reading Messages  
 
From the Inbox, Sent Mail, you can open all messages received or sent by you. The Draft Tab displays drafts of 
your message that you have saved. The Folder tab, Trash tab displays filed messages in these folders.  

To read a message:  

1. Click the Inbox tab to see a list of messages.  
o Click the Inbox, Sent Mail, Drafts tab to see messages in the respective window.  
o Click the Folder tab to see folders where messages are filed.  

2. To open a specific message, click its subject.  
3. When you finish reading the message, click on a tab to go to the selected tabs Window or click 

the Close icon.  

 

Deleting Messages  
 
Depending on the Delete Options you set, you can delete messages temporarily or permanently from the Inbox, 
Sent Mail, Trash and Draft windows.  

These are your options:  

• If your Delete option is set to "Move Deleted Messages to the Trash," when you click Delete, the 
deleted message is moved from the current folder to the Trash Folder.  

If your Delete option is set to "Mark Messages Deleted," when you click Delete, Messenger Express marks each 
selected message for deletion. When you click Expunge, messages are permanently removed without saving a 
backup copy of the message.  
 
To delete messages from the Inbox or other folder (except the Trash folder):  

1. Click the Inbox, Folder, Drafts or Sent Mail tab select the message(s) you want to delete.  
o To select a single message, click its checkbox.  
o To deselect a message, click its selected checkbox.  
o To select all messages, click Select All.   
o To deselect all messages, click Deselect All.  

2. Click Delete.  

The message(s) are sent to the Trash Folder or marked Deleted.  
To remove deleted messages from the Trash Folder:  

1. Click the Folder tab to see the list of your folders.  

Click Empty Trash to clear the entire contents of the trash folder. Or:  

2 Click the Trash Folder to see your deleted messages.  

You can also select specific messages you want to delete:  

o To select a single message, click its checkbox.  
o To deselect a selected message, click its selected checkbox.  
o To select all messages, click Select All.  
o To deselect all selected messages, click Deselect All.  

3 After you have made your selections, click Delete.  



The message(s) are deleted from the Trash Folder. A backup copy is not saved.  
 

Viewing Attached Files  
 
To view a file attached to a message:  

• In the message, click the name of the attached file, next to Attachments in the header section of 
the message. A dialog box appears.  

• You can view the file from its current location without downloading it. Alternatively you can save 
the attachment into a selected folder.  

Saving Attached Files  
 
If you receive an attached file, such as a GIF or JPEG file, you can save it to your local disk.  

To save an attachment:  

1. Use the Save As function of your browser to save the attachment.  

Or  
Right click the name of the attached file, in the message header next to Attachments (In the case 
of GIF or JPEG files, which are displayed inline, you will need to right-click on the image).  
A menu appears.  

2. From the menu, choose Save Link As. The "Save As" dialog box appears.  

3. In the File Name field enter the name of the attachment to be saved.  

4. Click Save.  

Collecting External Mail  
 
Messenger Express lets you collect mail from another account using the Post Office Protocol (POP). For 
example, if you have a POP userID on servername.com, you can collect your mail from your 
servername.com account and view it with Messenger Express.  

To collect POP messages from another server:  

1. Click the Inbox, Folder, Sent Mail,or Trash tab.  

2. Click Collect External Mail, in the bottom right of the Inbox or Folder tabs.  

A POP collection window appears where you specify what you want and identify yourself. 

Table 2 POP collection 
Window Items  
 
POP Server   

Enter the name of the server from which you want mail collected.   

POP User ID   Enter the user ID of the mail account from which you want mail collected. 
  

Password   Enter the password for the mail account from which you want mail 
collected.   

Delete messages from 
server   

If you want the mail you are collecting to be deleted from the server from 
which it's being collected, click the checkbox to select it.   

Save to Folder   From the drop-down list, choose a folder to which you want the mail 
copied.   

3. Click Collect.  



Composing Messages  
 
Messenger Express allows you to compose messages, look up recipient addresses, draft a message, and attach 
files to messages.  

To compose a message:  

1. Access the Compose window by following one of the three methods:  
o Click the Compose icon from a tab, which has a compose icon.  
o From the Addresses tab, click the Search icon. Then click Compose Message. This 

method is usually used after you have searched and found a recipient's email address  
o From the Addresses tab, click a recipient's email address. If you choose this option, the 

compose window will appear with the address of your selected recipient in the To: field. 
When you choose this method, unless you want to add other recipients, you can skip 
step 2.  

2. Enter the required email addresses yourself or if you do not know an address, perform a search. 
You can enter email addresses in one or more of the following fields: 

Table 3 The To:, 
Cc:, and Bcc: 
Fields  
 
To:   

Enter a recipient's email address in this field to address a message to the 
recipient.   

Cc:   Enter a recipient's email address in this field to send a copy of a message to that 
recipient.   

Bcc:   Enter a recipient's email address in this field to send a blind copy of a message 
to that recipient. A blind copy is one in which other recipients cannot see who 
else has received the same message.   

3. Click the Subject field and type the subject of your message.  

4. Click in the message text box, and type the text of the message.  

5. From the Priority drop-down list, select the priority as Normal, Urgent or Non-Urgent.  

6. From the Request receipt drop-down list, select the option you want. For example: None, When 
delivered, When Viewed, Both.  

7. From the top or bottom of the window, click Send.  

 

Composing a Draft of a Message  
 
To draft a message to be sent later:  

1. Click the Compose icon from any tab, except the Options tab.  

When the Compose Message window appears, your cursor will be in the Recipients box ready 
for you to enter the email addresses of people to whom you want to send the message. You can 
enter the email address now, or wait until you are ready to send the draft.  

2. Click in the Subject field. Enter a subject for your message.  

3. To compose a draft, click the top left of the message text box, and type the text of the message.  

After composing the Draft, click the Save Draft icon on the Compose Message icon bar.  

Searching for Addresses  
 



Messenger Express has a feature for looking up email addresses and telephone numbers. This feature can be 
accessed using one of the following two methods:  

• From the Compose icon: this method can be used for composing a message to a single recipient, 
but it is especially useful for building a list of recipients.  

• From the Search icon (in the Addresses tab): this method is most suitable when you want to 
email a single recipient or you simply want to look up an email address or even a phone number. 
You can use this method to find and edit a name in a lengthy personal address book.  

For example, if you already know that a recipient's first name is John, but you are not sure of the 
spelling, you can specify the search criteria:  
"First name sounds like John"  
Another example is, if you know the recipient's phone number is 555-1212, you can specify the 
search criteria:  
"Phone number is 555-1212"  

To search for an address when you are starting from the Search icon within the Addresses tab, perform the 
following:  

1. Click Search to go to the "Search for Recipient" window.  

2. From the "Personal Address Book" drop-down list, select a directory.  

3. From the "Full Name" drop-down list, select the element you want to search. For example: First 
name, Last name, Email, Phone#.  

4. From the "contains" drop-down list, select the type of search you want to perform. For example: 
contains, is, sounds like, begins with, ends with.  

5. In the text field, enter the keyword or keywords you want to search.  

6. Click Search. Messenger Express lists all the entries that match the search criteria.  

Attaching Files to a Message  
 
You can attach and send any file that is on a disk connected to your computer, or residing on your computer. 
When you specify a file to attach, a copy of the file is attached to the message; the original remains in place.  

To send an attachment with a message:  

1. From the "Compose Message" window, Click the Attach icon.  

2. Click Browse to select the file you want to attach.  

3. Select the file you want to attach.  

4. Click Open to select the file.  

5. Click Add to attach the file to your email. You can attach multiple files to your message. However, 
the total size of your message including attachments should not exceed 5 MB.  

Click Remove to delete a file selected for attachment.  

6. Click the Attach button in the Attach file dialog box.  

The Attach file dialog box closes, and the name of the file you attached appears in the 
Attachment field in the Compose Window.  

 

Formatting Text  
 
When using Internet Explorer 5.0 or later as your Web browser, you can change the text color, size, and 
alignment of your message along with various other message attributes.  



1. From the "Compose Message" window, if the text formatting toolbar is not visible, click the 
Text/HTML icon on the Compose Message icon bar.  

2. Click the location where you want new formatting to start . If you want to change the formatting of 
text, select the text you want to change.  

Click the formatting tool you want to use or select the option you want from one of the drop-down lists.  

 

 

Checking Spelling  
 
Check the spelling of messages you compose with the spell checker. You can invoke a spell check at anytime 
while the compose window is open by performing both of the following steps:  

1. Select the appropriate language from the Dictionary drop-down list (not necessary if the 
appropriate language is already selected).  

2. Click the Spell Check icon on the Compose Message icon bar.  

You can also ensure that the spell checker automatically checks the spelling of a message before you send it by 
clicking the checkbox next to "Check spelling before message is sent" option.  

With this option checked, clicking Send invokes the spell checker. You can automatically set this option for all 
messages you compose.  

Once the spell checker is invoked, it copies the message into a new window. The spell checker highlights all 
words that it does not recognize. Ignore highlighted words that are correctly spelled, such as people's names, 
abbreviations, or new technological terms. The spellchecker does not recognize many of these words.  

To change a word that the spell checker has highlighted, follow these steps:  

1. Click a highlighted word in order to select it.  

2. Edit the word yourself directly in the Change field or, to replace it with a word from the suggested 
word list, click a suggested word. If the spell checker does not have any suggestions, it displays 
the message "No Suggestions."  

3. Click one of the following:  
o Change, to replace the highlighted word that you selected.  
o Change All, to replace all instances of that word within your message.  
o Ignore All, to ignore the word you selected and all other instances of the word within 

your message. This removes the highlighting from all occurrences of the selected word.  



Notice that each time you change a highlighted word the spell checker returns you to the 
beginning of your message. This behavior is more apparent in long messages.  

4. When you are finished checking the spellings in your message, click Done. Clicking Done has a 
different effect depending on how the spell checker was invoked and if you have any remaining 
highlighted words or not. The following list describes the various behaviors that can be 
encountered:  

o If the spell checker was invoked by clicking Spell Check, clicking Done when no 
highlighted words remain brings you back to the Compose Message window.  

o If the spell checker was invoked by clicking Spell Check, clicking Done when highlighted 
words remain brings up an alert message.   

Close the alert message window to return to the Compose Message window.  

o If the spell checker was invoked by clicking Send (this only occurs when the "Check 
spelling before message is sent" option is selected), clicking Done is not necessary if no 
highlighted words remain. The message is sent instantly after you change the last 
remaining highlighted word.  

o If the spell checker was invoked by clicking Send (this only occurs when the "Check 
spelling before message is sent" option is selected), clicking Done when highlighted 
words remain brings up an alert message. Do one of the following :  

a) Click OK to send the message.  
b) Click Cancel to return to the Spell Check window.  

 

Sending a Message  

• To send a message, you have two options:  
o Click the Send icon in the top left corner of the Compose Message window.  
o Click the Send button in the bottom right corner of the Compose Message window.  

Working with Messages  
 
Deleting a Message  
 
To delete a message:  

1. Click the Subject of the message.  

This opens the message for viewing.  

2. Click Delete.  

Replying to a Message  
 
You can reply to the sender of a message, or to the sender and to all recipients listed in the To, From, Cc fields of 
the original message.  

To reply to a message:  

1. Click Reply to reply to the sender, or Reply All to reply to the sender and all the other recipients.  

A Compose Message window appears with the name of the recipient or recipients. The subject of 
the original message is prefaced with Re:.  

2. If you want to enter additional email addresses, click "To", "Cc", or "Bcc" to indicate how you 
want the address to be listed. Alternatively, you can manually add an email address.  

3. Click in the message box and type the text of your message. Click Send.  

Forwarding Messages  
 
To forward an opened message, and any files attached to it:  



1. Click Forward.  

2. Address the message, using To, Cc and Bcc header fields.  

Messenger Express enters the subject of the original message, prefaced with Fwd:. Attachments 
that came with the original message are included.  
In the text box, write a message if required.  
 
The original message appears in the attachment field labeled original message. New 
attachments if any sent with the original message also appears in the attachment field along with 
the original message forwarded.  
 

Working with the Personal Address Book  
 
Creating a New Address Entry  
 
Use the Addresses tab to add an individual to your personal address book. A personal address book entry stores 
names, email addresses, phone numbers, business or home address, notes, groups, home page links, and more.  

To create an address entry for an individual:  

1. Click the Addresses tab.  

2. Click the New Contact icon.  

The New Contact dialog box appears.  

3. Within the Name & Contact tab, enter information about the individual.  

The Name and Contact tab allows you to enter the recipient's first name, last name, email 
address, work phone, home phone, mobile, pager, and fax numbers. By default the Display 
Name is the name you type in the first and last name fields. You can edit the Display Name.  

4. Click Address tab if you want to enter the recipients postal address details, home page, and 
birthday details.  

5. Click the Notes tab if you want to write notes about the recipient.  

For example, if the recipient is a member of a club in which you belong, you might enter the 
name of the club in the notes box.  

6. Click the Groups tab to get a list of mail groups.  

A list of address groups you have created is displayed. To add the recipient to a group, select the 
box next to the group name to insert a checkmark.  

7. Click OK to save the contact details and exit the New Contact dialog box.  

8. In the Address tab window, against the name you want to send your message select To:, Cc: or 
Bcc:  

Creating a New Group  
 
Use this option to create a new group, if you regularly send messages to a group of email recipients.  

To create a new group:  

1. Click the Addresses tab.  

2. Click the New Group icon.  

The Group Members tab dialog box appears.  



3. Enter a name in the Group Name field.  

This can be a name that describes a group of email users.  

4. Select the type of individuals you want to include in the New Group from "View" drop-down list. 
For example select All, Groups Only or a <User Defined Group> to filter the selection shown in 
the available list.  

5. Click the Add > button to move the email recipient to the Group Includes panel.  

Click the <Remove button to remove member(s) from the Group Includes panel.  

6. Click the Search button to search for names and addresses to be included in the new group. 
Enter the following search details:  

o An Address Lookup dialog box appears. You can search the Personal Address book for 
contacts or groups.  

o From the "Full name" drop-down list, select an item from the available list. For example: 
Full name, First name, Last name, Email, Phone number.  

o From the "contains" drop-down list, select an item from the available list. For example: 
contains, is, sounds like, begins with, ends with.  

o Enter the text of the item you are searching on in the blank field (next to the "contains" 
drop-down list).   

o Click Search.  
o A list of names or groups matching the search criteria appears.   
o Select the names or groups and click Apply or OK.   

If you click Apply, the selected search result is added to the New Group list and you can 
perform another search in the Address Lookup dialog box.  
If you click OK, the Address Lookup dialog box closes and the selected search result is 
added to the New Group list.  

7. Click the Notes tab to make notes about the group you are creating.  

8. Click OK to save the new group details.  

Managing Your Account  
 
Password  
 
To change your Password:  

1. Click the Options tab.  

2. Click the Password box on the left panel. You have three prompts, all of which must be filled in:  
o Enter your old password:  
o Enter your new password:  
o Confirm your new password:  
o Click Change Password to confirm new password, or Reset to retain old password.  

Spell Check  
When you select this option, messages you compose are automatically spell checked after you click Send.  

Sent Messages  
This option lets you save a copy of every message you send to a specific folder. To choose a folder, use the 
drop-down list.  

Mail Forwarding  
Use this option to send a copy of every message you receive to a specific email address. For example, if John 
wants to send Carolyn a copy of every message he receives, he would enter Carolyn's email address in the 
"Forward copies of new messages to" box. You can enter as many email addresses as you want in the box, one 
line at time.  

Composing Vacation Messages  
 



Follow these steps to activate or deactivate the sending of vacation messages and to write the message you 
want sent in response to email messages while you are away.  

1. Click the Options tab.  

2. Click the Vacation Message box on the left panel.  

3. Turn your vacation message on or off.  
o To toggle on the vacation message reply, click the box labeled "Enable automatic 

vacation reply".   
o To toggle off the vacation reply message, click the box labeled "Enable automatic 

vacation reply".  

4. Type a start date and end date for your vacation message.  

The start date is the current date, and the end date should be the date you want the vacation 
mail to stop.  

5. In the text box, type the number of days after which you would like a reply sent to a repeat mail 
sender.  

The number of days entered here is the number of days between automatic replies to a repeat 
mail sender. This means a sender will receive one vacation reply, no matter how many 
messages he sends to you, during the time period you specify.  

6. Type a subject for the message or leave it blank.  

If you leave $SUBJECT in this field, then the subject of the message sent to you will be the 
subject of your reply.  

7. In the text boxes, type your internal and external vacation message.  

Internal messages are sent to users in the same domain; and external messages are sent to all 
other users.  
These messages are sent only when the box to enable vacation messages is checked.  

8. Click Save Changes.   

 


